
  Trang 1/13 

Hướng Dẫn Cách Sử Dụng Wavepad Để Thu Âm vào Máy Tinh 
 

WavePad là một nhu liệu bán với giá phải chăng (38 USD) có tính chất vừa giản dị vừa dễ sử dụng. 
Nhưng nến chỉ dùng nhu liệu này với mục đích như thu bài giảng hay kinh từ cassette vào máy tính hoặc 
chỉ dùng để edit như cắt hay nối files lại với nhau thì chỉ cần một phiên bản miễn phí cũng đủ để làm 
tròn công việc này. 

Có thể hạ tải nhu liệu Wavepad miễn phí từ trang nhà NCH Corp sau đây: 
http://www.nch.com.au/wavepad/masters.html. Nhu liệu miễn phí có một số chức năng bị giới hạn.  

Bài Hướng Dẫn Cách Cài Đặt và Sử Dụng nhu liệu WavePad này nhằm giúp việc thu âm vào 
máy tính được thực hiện một cách dễ dàng. Trong phạm vi nhỏ hẹp, bài này chỉ đề cập đến một vài chức 
năng của nhu liệu WavePad để người mới sử dụng có cơ hội làm quen với nó chứ không giới thiệu tất cả 
chức năng của nhu liệu này. Người sử dụng cũng có thể thí nghiệm với nhu liệu này vì dù là phiên bản 
miễn phí nhưng nó cũng  có những chức năng cần thiết để hoàn thành những công tác đơn giản.  
 

Cách Kết Nối Dây Cáp Để Thu Âm 
 
Để thu âm vào máy tính cần phải có các thiết bị như sau: 
1. Máy tính có lắp một cạc âm thanh (sound card) 
2. Đầu máy cassette loại thường (tape deck) hoặc loại bỏ túi (portable) cũng được. 
3. Dây cáp để nối từ đầy máy cassette đến máy tinh.  
 

 

 
Dây cáp loại 1 

Dành cho đầu máy thường 
Dây cáp loại 2 

Dành cho loại cassette bỏ túi (portable) 
 

Cách nối dây cáp rất giản dị: chỉ gắn một đầu của dây cáp vào sound card trong máy tínhvà gắn đầu kia 
vào đầu máy cassette. Chỉ dùng một dây cáp mà thôi.  
1. Máy cassette thường: Khi dùng máy này, phải nối bằng loại dây cáp 1 theo hình trên.  

a. Nối đầu 3.5mm vào chấu có tên LINE IN trên sound card nằm ở phía sau máy tính. 
b. Nối đầu dây cáp có hai chấu vào LINE OUT của đầu máy cassette. Nối sao cho hai màu của 

hai chấu trên dây cáp tiệp với hai màu của hai trụ LINE OUT trên máy cassette.  
2. Máy cassette loại bỏ túi: Loại máy này có đầu cắm giống như đầu cắm của sound card nên dùng 

loại cáp 2. Nối đầu nào vào chấu nào cũng giống nhau. 
3. Lưu Ý:  

a. Đôi khi dây cáp loại 1 có hai màu không tiệp với 2 màu trên máy cassette, thông thường màu 
đỏ dành cho channel PHẢI (R) và màu trắng dành cho channel TRÁI (L) 

Đầu 3.5 mm 
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b. Chấu LINE IN trên sound card đôi khi không ghi tên rõ ràng mà chỉ khắc dấu hiệu hoặc vẽ 
hình một mũi tên chỉ vào tâm một vòng tròn. LINE OUT ngược lại có hình mũi tên từ tâm 
vòng tròn đi ra, chấu này dùng để nối vào loa . 

c. Nếu dùng cassette loại bỏ túi (hay các máy chơi nhạc MP3) có chấu cắm 2.5 mm, dây cáp 
loại 2 không dùng trong trường hợp này được. Muốn dùng loại máy này cần có một adapter 
để đổi chấu 3.5 mm sang 2.5 mm.  

d. Đừng bao giờ nối dây cáp vào chấu microphone trên sound card. Chấu này chỉ dùng cho máy 
vi âm (microphone) mà thôi. 

e. Đừng dùng chấu ống loa (Speaker Out) trên máy cassette để nối vào sound card. Ngỏ ra của 
loa có công suất cực mạnh có thể làm hư sound card. Nếu không có LINE OUT từ máy 
cassette, có thể dùng HEADPHONE OUT nhưng nhớ vặn VOLUME xuống thật nhỏ, sau đó 
từ từ vặn lớn thêm trong lúc thu âm để tránh làm hư hại sound card. 

f. Nếu muốn thu âm từ các máy MP3 vào máy tính cũng theo cách thức trong bài này. 
 

Cách Cài Đặt Nhu Liệu Wavepad 
 
o Cài nhu liệu WavePad vào máy tính bằng cách nhấn chuột 2 lần (nhấn đúp) vào chương trình 
(program) này (wpsetup.exe) .  

Lưu Ý: Nếu chương trình Convert còn ở dạng zip, phải bung ra dùng chương trình winzip 
chẳng hạn trước khi cài đặt . 

o Chọn I agree with these terms, khi màn License Agreement hiện lên. 
 

 
  

Hình 1 – Màn License Agreement  
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o Nhấn vào NEXT > để tiếp tục cài nhu liệu này vào máy. 
 

 
 

Hình 2. Next để tiếp tục cài vào máy 
  
o Đừng chọn nhu liệu nào khác khi màn Select Related Programs hiện lên (Hình 3) . 
o Nhấn vào ô Finish để đóng màn này lại và cũng để kết thúc việc cài đặt vào máy. 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

Hình 3. Màn Select Related Programs 
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o Sau khi được cài đặt hoàn hảo, WavePad tạo một biểu tượng (icon) có tên WavePad trên màn 
hình Desk top. 
o WavePad sẽ khởi động lần đầu tiên như trong Hình 4 
  
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hình 4.  WavePad đang hoạt động 
  
o Logo của Công Ty NCH  hiện ra trong vài giây rồi biến mất. 
o Muốn kiểm soát phiên bản nào đã cài vào máy, nhấn vào Help > About, trên màn WavePad 
(Hình 4).  
o Nhấn OK để đóng màn này. 
 
  

  
 
 
 
 
 
 
 
 
 
 
 

 
Hình 5. Phiên bản v3.05 này miễn phí (Unlicensed Basic Free Version). 

  
o Muốn đóng màn WavePad, nhấn vào File > Exit hoặc nhấn vào biểu tượng có chữ X đỏ ở góc 
phải trên cùng theo Hình 4. 

Đóng 
màn 
hình 
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Cách Sử Dụng Phần Mềm WavePad 
 

o Cách khởi động WavePad: 
o Khởi động Wavepad bằng cách nhấn đúp vào biểu tượng Wavepad trên desktop.  
o Wavepad hiện ra như Hình 6.  
 

 
  

Hình 6. Wavepad đang hoạt động 
  
o Cách mở file 
o Mở một file mới bằng cách nhấn vào biểu tượng New File (Hình 6) 
o Khung hình New File xuất hiện. (Hình 7) 
o Chọn Sample Rate : 22050 (cho bài giảng). Chọn 44100 cho âm nhạc.   
o Chọn Channels: Mono (cho bài giảng hoặc Stereo cho âm nhạc) 
o OK để đóng. 
Lưu Ý: Nếu muốn mở một file đã lưu trong máy nhấn vào biểu tượng Open File nằm kế bên biểu tượng 
New File. 
  

 
 
 
 
 
 
 
 
 
 

 
Hình 7. Chọn Sample Rate và Channels 

 

Chọn 
sample 
rate 



  Trang 6/13 

Một cửa sổ mới (Untitled 1) sẽ hiện ra, nằm trong khung hình WavePad (Hình 8). Cửa sổ này sẽ là cửa 
sổ chính gọi là Cửa Sổ Sóng (Wave Windows) dùng làm nơi chứa sóng âm thu được để edit. 
 

 
 

Hình 8. Nhấn vào nút RECORD để bắt đầu thu âm 
 

o Cách sắp xếp trước khi thu 
o Khi đã sẳn sàng, nhấn vào nút RECORD, WavePad sẽ khởi động việc thu âm.  

 
Khi mới thu âm lần đầu, cần kiểm soát lại cách sắp xếp theo mặc định (default) của chương trình 

WavePad. Động tác này chỉ làm một lần hoặc chỉ làm khi nào cần thiết mà thôi. Trong phần này đừng 
bật máy cassette lên vội nhưng nếu muốn bỏ qua phần nay thì bật cassette lên là máy tính sẽ thu vào 
ngay.     

 
Cần phải sắp đặt hoặc kiểm chứng các điều kiện sau đây:  

- Chọn nguồn phát âm để máy tính biết âm thu từ đâu vào. 
- Các điều kiện mặc nhiên do WavePad tạo ra khi cài đặt.  

 

 
 

Hình 9. Màn Record Control 
 

Nút 
thu 
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o a. Chọn nguồn phát âm thanh 
o Khi màn Record Control hiện ra, nhấn vào Open Windows Record Mixer (Hình 9) 
 

 
 

Hình 10. Dùng màn Recording Control để chọn ngỏ đưa âm vào máy 
 
o Màn Recording Control hiện ra (Hình 10). Chọn Line In bằng cách nhấn vào ô Select. Chỉnh 
nút điều chỉnh âm thanh nằm vào vị trí giữa  
Lưu Ý: Màn này cũng dùng để điều chỉnh âm thanh trong lúc thu. Muốn tăng âm lượng kéo nút điều 
chỉnh Volume lên, muốn giảm kéo xuống xem Hình 11.  
Có thể đóng màn này lại theo Hình 11. Màn này có thể mở ra bất kỳ lúc nào theo cách thức chỉ dẫn trên 
để chỉnh Volume hoặc để thay đổi ngỏ vào để thu âm. 
 

 
 

Hình 11. Recording Control sau khi chọn Line In là nguồn phát âm 
  

Điều 
chỉnh 
âm 
thanh 

Đóng 
màn 
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o b. Phần sắp xếp cao cấp 
o Dùng Hình 9 để theo phần chỉ dẫn sau. Nhấn vào Advanced Record Settings.  
o Chọn lựa các mục sau tùy theo sở thích của người sử dụng (Hình 12). Chọn bằng cách nhấn vào 
các ô trống bên trái. 
 

- Thu tự động (Auto Start Recording) 
- Cắt bỏ tự động (Auto Trim Recording) 
- Phát hiện âm tự động (Voice Activated Recording) 
 

 
 

Hình 12. Cách sắp xếp Wavepad khi thu tự động 
 

Công dụng của các mục trên được tóm tắc như sau: 
 

- Thu tự động: Việc thu thanh chỉ thực sự bắt đầu khi âm thanh được phát hiện. Nếu chưa bật cassette lên 
hoặc đã bật lên mả chỉ là băng trống (không có tiêng) thu âm cũng chưa bắt đầu. 

   
- Cắt bỏ động: Auto Trim Recording sẽ tự động xóa đi phần không có tiếng ở đoạn đầu cũng như đoạn 

cuối của âm đã ghi vào.  
 
- Phát hiện âm tự động: Âm chỉ được ghi vào khi nào mức độ đưa vào cao hơn là mức được chỉ định ở 

trong ô Threshold. 
 

o Nhấn OK để đóng màn này. 
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BẮT ĐẦU THU ÂM 
 

o Cách thu âm 
Lưu Ý: Lúc này WavePad có thể đang thu âm (RECORD), tùy theo cách sắp xếp ở giai đoạn trên 

(Advanced Record Settings). Nếu nút RECORD bị đè xuống WavePad đang trong giai đoạn thu âm. 
o Bắt đầu cho máy cassette chạy.  
o Trong khung hình Record Control (Hình 13) tín hiệu hiện lên và biến đổi tùy theo âm lượng lớn 
nhỏ đưa vào máy. 
Lưu Ý: Trong lúc thu âm phải để ý đừng cho âm thanh vượt quá mức độ nếu không âm thanh thu được 
bị xén làm mất chất lượng và âm sẽ khó nghe. 

Điều chỉnh âm lượng (Volume) (như đề cập ở trên, Hình 11) để âm thanh thu vào vừa đủ, mực 
thu biểu diễn bằng các thanh màu xanh luôn luôn hiện ra và ít thanh màu đỏ hiện ra nhiều lần liên tiếp.  
o Điều chỉnh âm thanh vào máy bằng 2 cách: 

1.   Điều chỉnh âm lượng từ máy cassette. 
2. Điều chỉnh âm lượng dùng nút Volume ở ngõ Line In trong Hình 11.  

 

 
  

Hình 13. Đang thu âm (khi nút thu màu đỏ nằm thụt xuống) 
 

 
 
 
 

Đang 
thu âm 

Nhấn 
STOP sẽ 
ngừng 
thu âm Giữ cho Sóng thu 

vào ở mức xanh 
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o Cách ngừng thu 
o Ngưng máy cassette trước khi nhấn vào nút Stop để ngừng thu .  

Khi ngừng thu, tín hiệu sóng sẽ chuyển vào khung cửa sổ như (Hình 14). Xin chú ý đến một 
hàng số chỉ thời lượng thu âm ở phía dưới bên phải màn hình: đó là tổng số thời gian mà âm thanh đã 
được thu vào máy tính. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hình 14. Ngừng thu âm khi nút Stop đè xuống) 
 
 
 

o Thời lượng có định dạng như sau: 
o GIỜ: PHÚT: GIÂY. % của một giây 
o Cách đọc các con số biểu diễn thời lượng thu âm như sau: 

Thí dụ: 0:01:26.79 
0 -> 0 giờ 
0 -> 01 phút 
26 -> 26 giây 
79 -> 79 phần trăm của 1 giây 

 
 

Điều 
chỉnh âm 

Đóng 
cửa sổ 

Thời lượng đã 
thu  

Máy đã 
ngừng thu  
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o Cách nghe thử âm mới thu 
Âm vừa mới thu có thể phát lại để nghe thử, kết quả có thể lưu vào đĩa hoặc xóa và thu lại file 

khác. 
o Nhấn vào Go to Start (Home) để quay lại từ đầu và nhấn Play.  

Thanh điều khiển trong Hình Record Control cũng có công dụng như thanh điều khiển của máy 
cassette nên cách sử dụng cũng như nhau. Muốn nghe phải mở máy ampli ra.  
o Điều chỉnh âm thanh để vừa đủ nghe dùng Volume trong Hình 14. Nút điều chỉnh này không ảnh 
hưởng gì đến âm thu nó chỉ ảnh hưởng đến ampli và loa của máy tính mà thôi. 
o Khi đã vừa ý, đóng khung này bằng cách nhấn vào ô có dấu X ở góc phải. (Hình 14) 
Lưu Ý: Muốn thu âm lại cũng phải đóng khung này và bắt đầu từ đầu.  
o Sau khi đóng khung Record Control, tín hiệu sóng thu vào sẽ chuyển qua Cửa Sổ Sóng (Wave 
Window) như Hình 15 sau đây. 
 

 
 

Hình 15. Màn WavePad sau khi đóng Record Control 
 
 

o Đến đây tín hiệu sóng có thể nghe lại, edit theo ý muốn như xóa đi phần thừa hoặc nhập thêm 
file đã thu từ trước, hoặc tác động các hiệu ứng (effects) của chương trình WavePad lên file này để lọc 
các nhiễu âm hay làm âm được hoàn hảo hơn. 

 

PLAY 

Quay lại từ 
đầu 

FILE > 
SAVE 
AS 
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o Cách lưu trữ file mới thu 
o Nếu muốn lưu trữ file này, nhấn vào File > Save File As (Hình 15) 

Gõ theo chỉ dẫn ở Hình 16 (Save Audio File As) 
o Save In: Chọn folder, thí dụ My Music. 
o File Name: Chọn tên cho file vừa mới thu, thí dụ Bai Giang1.  
o Save as type : Chọn thể loại, MP3 (MPEG Layer-3) 

Lưu Ý: Có thể chọn thể loại khác như wav chẳng hạn. 
 

 
  

Hình 16. Cách lưu trữ file 
 

o Nhấn vào Save. 
 

 
 

Hình 17. Đặt tên file và xác định folder để lưu 

Chọn thể loại  
file: MP3 

Chọn tên 
file 

Chọn folder 
Tạo một 
folder mới 
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o Cách xếp đặt MP3 
Nếu chọn thể loại file là MP3 cần xác định các mục sau đây: 

o Chọn Constant Bitrate (CBR) 
o Bitrate (kbps): Chọn 32 kbps 
o Channels: Chọn Mono (Stereo dành cho âm nhạc). 
 

 
 

Hình 17. Chọn thể MP3 để lưu trữ. 
 
 

o Click OK. 
File sẽ được lưu vào folder đã chọn ở trên. 
Đến đây là kết thúc phần thu âm và lưu file thu vào máy. 

 
Đề Nghị 

 
Bài hướng dẫn này rất là căn bản không đi vào chi tiết hướng dẫn cách edit file. Cũng xin đề cập ở 

đây: cách hướng dẫn để thu cassette trên đây cũng có thể áp dụng cho các thiết bị khác như máy chơi 
nhạc MP3 hay bất kỳ thiết bị nào có chấu ra dùng loại RCA hoặc mini jack như phần chỉ cách nối dây 
cáp trên.  

WavePad cũng có thể dùng để thu âm trong khi nghe bài giảng hoặc kinh trên mạng, chỉ cần thay đổi 
ngỏ vào của âm là Wave Out Mix (Hình 11) thay vì LINE IN. Cách này cũng tiện lợi vì chỉ thu và lưu 
lại trong máy tính những bài nào hoặc đoạn nào cần thiết mà thôi. 

Chọn Channels 
cho MP3 

Chọn Bitrate 
cho MP3 


